
Chapter 3 – Word Processing Tool 
 

Exercise 

Short Answer Type Questions 

Question 1: 

What is a cursor? 

Answer 1: 

Generally, the cursor looks like the arrow or a pointer. It changes into a hand icon 

when it moves over a hyperlink. The cursor on the computer screen indicates 

where a mouse pointer is, and where the next letter will be placed in a line of text. 

When the cursor is over an object, the user can click or double click the mouse 

left button to open it. Similarly, text cursor makes the user easy to insert a word 

or a phrase anywhere in the line of text. 

Question 2: 

How many types of text alignments are there? 

Answer 2: 
There are 4 types of alignment in the word 

• Left –aligned  

1. Technically it is called “flush left”. 
2. Shortcut key for left alignment is Ctrl+L. 
3. it helps to align text in the left position in MS word.  

• Right-aligned 

1. Technically it is called "flush right." 
2. Shortcut key for right alignment is Ctrl+R. 
3. It helps to align text in the right position in MS word.  

• Center-aligned 

1. Shortcut key for right alignment is Ctrl+E. 
2. It helps to align text in the centre of the page in MS word.  
3. When user types, the text expands equally to the left and right, leaving the 

same margin on both sides. 



• Justified-aligned 

1. Shortcut key for right alignment is Ctrl+J. 
2. It combines left and right-aligned text. 
3. Each line fills the entire space from left to right when a block of text is 

justified. 

Question 3: 

What are the methods of selecting a line in MS-Word? 

Answer 3: 
These are some methods of selecting lines in MS-word. 

Select all text 

• Click within the document and press “Ctrl+A” on the keyboard to select all 
text of it.  

Select specific text 

• Place a cursor in front of the letter, click and hold left mouse button and 
drag cursor to select text. 

Other ways to select text 

• To select a line. Place a cursor in first word, then press “Shift+ down 
arrow”. 

• Press “Ctrl+ Shift +down” arrow to select a whole paragraph. 

Question 4: 

How many types of page orientations are there in page setup? 

Answer 4: 

• Portrait Orientation 

1. It’s a default setting of the document.  
2. A page with this orientation is taller than it’s wide. 
3. It is used typically for letters, memos and other text. 

• Landscape Orientation 

1. A page with this orientation is wider than it is tall. 



2. It is not frequently used because all printers are not capable of generating 
text in this mode. 

Question 5: 

What are the views used in word processors? 

Answer 5: 

• Print layout view: This is the default view you will find when you open the 
document. This view is best used when your document contains images, 
headers, footers, columns, etc. Each of these components is visible. In this 
view, you can see how to print documents based on page breaks. 

• Full-screen reading view: Full-screen reading view is optimized to read 
documents on the computer screen. In full-screen mode, you can also 
choose to view the document as if it were displayed on a printed page. You 
should view the document in full-screen reading view to read the document 
as much as possible or add comments to the document. 

• Web layout view: The web page layout mode is used to view your 
document in the same way as a web page. In this view, you can see the 
background, the text is wrapped to fit the window, and the image is 
displayed online. 

• Outline view: Using an outline view, we can view the document as an 
outline and show the outlining tools. This is useful if we move sections of 
our document, or creating an outline. 

• Draft view: A draft view is used to view the document as a draft, to enable 
you to quickly edit the text. Some elements of the document (for example, 
headers and footers) will not be visible in this view 

Question 6: 

How can words be added in word processors, dictionary? 

Answer 6: 

Add new word through a custom dictionary 

• In the menu bar, click the file tab, and then click options. 
• In the word options window, click the proofing option in the left navigation 

pane. 



• Under the ''when correcting spelling in Microsoft Office programs'' header, 
make sure the box is unchecked for the 'Suggest from main dictionary only' 
option. 

• Click the ''custom dictionaries button''. 
• In the custom dictionaries window, select the dictionary set as the default 

dictionary, then click the ''edit word list button. 
• Type the word you want to add in the word text field. 
• Click the 'Add' button to add the word to the Microsoft word dictionary. 
• Click the OK button on each of the open windows to save the dictionary 

changes. 

Add new word during a spell check 

• When writing a document, words that Microsoft Word considers incorrect 
have a red twisted line below them. Right-click on the word with a red wavy 
line under it. 

• In the pop-up menu that opens, select spelling, then the ''add to dictionary'' 
option. 

Question 7: 

List the advantages of word processors. 

Answer 7: 

Some advantages of word processors are listed below: 

• Word processing software was first widely used on personal computers in 
the 1980s. In many offices, the importance of word processing tools like 
Microsoft Word and Google Docs cannot be overemphasized. 

• Benefits of word processors also include the ease of making corrections 
and the ability to collaborate on editing documents. 

• Modern word processing programs also allow multiple people to edit the 
same document together, which can improve the work efficiency of office 
workers and students. 

• This software has largely replaced typewriters, including simple fixes and 
the reason they require relatively little maintenance compared to 
typewriters that require maintenance and ink changes. In general, noise 
from a computer keyboard is less than from a typewriter, which is also an 
advantage in some environments 

• The word processor also provides a variety of fonts, text colors, and other 
formatting options, which are usually not available to end-users using 



other devices. Many also provide built-in spelling and grammar boards, 
which are useful for proofreading. 

 

Long Answer Type Questions 

Question 1: 
Give the steps to insert a clip art picture to your document. 

Answer 1: 
In documents adding images and pictures could be helpful to understand the 
information. An image can be inserted directly from your computer or download 
from the internet. After you finalize the picture you want, you can format or add 
text in the image. To know more about inserting a clip art to the documents. 
Some of the useful points are listed below which will help you. 

To locate a clip art: 

1. Select the Insert tab. 
2. In illustrations, group click the Clip art command 
3. A task pane appears on the right side of a document. 
4. Enter the keyword in 'search for' field and select the suitable option in 

'search in' and 'results should be' fields 
5. Deselect any types of media you do not want to see. 
6. Click Go 

To insert clip art: 

1. Review the results from a clip art search. 
2. Place your insertion point in the document where you want to insert the 

clip art. 
3. Click an image in the Clip Art pane. It will appear in the document. 

Question 2: 
What is formatting? Discuss the different types of formatting that you can have 
using a word processor. 

Answer 2: 
The different types of formatting are listed below: 

Character or font formatting: The smallest unit of the character format that can 
be used is a character (letter, number, or other). Thus, a line of text can have a 



different font formatting style for each letter and number (including spaces). 
Although you don't set an arbitrary text format, you can use the character format 
in Microsoft Word to do this. Character font formatting includes size, style, color 
and other font enhancements.  

Paragraph formatting: A paragraph is defined by a paragraph mark at the end of 
the text. The paragraph format description is not stored in the code at the 
beginning of the paragraph, but in the paragraph mark at the end of each 
paragraph. The advantage of this method is that after setting the paragraph 
format, you only need to press the [Enter] key, and all paragraph formats (and any 
current character format) will be "copied" into the next paragraph. This means 
there is no need to turn on indentation, bullets, tab stops, alignment, and another 
formatting for each new paragraph. 

Document or page formatting: This approach usually determines the appearance 
of the entire document regardless of the size of the document which includes 
margins, headers, footers, columns, page numbering, and other page formatting 
instructions. The page format is processed from the page setup group on the 
Page Layout tab. 

Section Formatting: The longer and more complex your document, the more 
likely it is that different parts will be required. The word parts are not chapters, 
which mean that they have nothing to do with the way the document is divided 
into headings and subheadings. 

Question 3: 
Discuss the different types of indentation. 

Answer 3: 
The different types of indentation are: 

• First-line indent: The indentation of the first line indicates the position of 
the actual bullet. If the paragraph does not appear in the bullet, it indicates 
the location of the first line of text. It leaves all other lines in the paragraph 
alone. 
 

• Left line indent: The left line indent allows you to adjust the two headings 
and keep their relative spacing. If you want to drag the top two indent 
markers and keep their relative distance, you can drag that mark. 
 

• Right line indent: The right margin controls the distance between the 
section and the right margin and has its own label. It is represented by a 



single triangle in the current right margin of the ruler. Click and drag to 
change fields. 
 

• Hanging indent: Hanging indentation indicates the location of the actual 
text line. If the part is not marked, it indicates the position of the second 
line (and subsequent lines) in the text. 

Question 4: 
How is line spacing different from space before or after paragraphs? 

Answer 4: 
It can be a good idea to change the line spacing in a section or between the 
sections itself for many reasons. Word provides some handy presets you can 
use, but you can also get full control by specifying the exact distance. 

• Line spacing determines the position of all lines in a paragraph. The 
spacing between paragraphs determines how much space should be 
before and after the paragraph. 
 

• For example, suppose you use a 12-point font for the text in a paragraph. If 
line spacing is selected, the line spacing is 12 points. 
 

• If the double spacing is selected, the line distance will be 24 points. But if 
you want to make fine adjustments, you can also specify the exact point 
size. 
 

• Paragraph works slightly differently. By default, Word adds eight space 
points after the paragraph and no extra spaces before the paragraph, and 
you can change these two values as needed. 
 

• Paragraph space allows you to add or remove predefined space just 
before or after a paragraph. And it's a little strange how it works. 
 

• If you currently do not have spaces before or after a paragraph, the menu 
displays commands for adding space in both places. If you add a space in 
one place, this command changes and you can remove that space. 

Question 5: 
What are the various facets of Paragraph Formatting? Explain each one clearly. 

Answer 5: 
The graphical user interface (GUI) Word provides the ability to apply a variety of 



formatting options to paragraphs. However, these options are not available in 
one place, and some of these locations differ in different versions of Word. 
Therefore, this page is divided into the following sections, each of which 
describes the related parameters. 

• The paragraph group: Many options are provided directly in the 
"Paragraph" section of the "Home" tab on the ribbon, the "Paragraph" group 
on the "Page Layout" tab, and the contextual toolbar and menu displayed 
when you right-click on the text. 

• The Paragraph dialog box: Any paragraph formatting options described in 
the previous sections and other paragraph formatting options are available 
in the Paragraph dialog box (two tabs) i.e. indents and spacing Line and 
page breaks. Before opening the Paragraph dialog box, place the cursor 
anywhere in a single paragraph to be formatted, or select multiple 
paragraphs to be formatted. To open the Paragraph dialog box, click the 
Paragraph dialog box in the Start section or the Page Layout tab at the 
bottom of the Paragraph group. 

• The Tabs dialogue box: When sections of text or other content on each 
line are separated by tabs, tab stops are used to align one or more lines of 
text or other content horizontally. When you set a tab stop, you can adjust 
it so that the text is aligned to the left of the tab stop, the text is right-
aligned, the centre is aligned, and the decimal point is aligned in or in front 
of the aligned text add a full or vertical line to the tab stop. In addition, you 
can customize a dashed, dotted, or solid line that extends from the text of 
the previous tab stop to the aligned text at the tab stop. 

• Keyboard shortcuts: The following table lists keyboard shortcuts (or 
keyboard shortcuts or keyboard shortcuts) that can be used to quickly 
apply paragraph formatting. 

Keyboard shortcuts for use in the paragraph formatting 

Key Action 

Ctrl + E Applies centre alignment 

Ctrl + J Applied justified alignment 

Ctrl + shift + J Spread the current section full width between the page 
margins 



Ctrl + M Increases the Indentation of the current section or selected 
section to the next tab stop 

Ctrl + shift + M Decreases the indentation to the preceding tab stop 

Ctrl + R Applies right alignment 

Shift + F1 Shows or hides the formatting properties in the task pane 

More information: For more information on line spacing, see "Change the default 
line spacing" and "Change the line spacing". See the "Adjust Indent and Spacing" 
section for more information on adjusting paragraph indentation. For more 
information on tabs, see the Microsoft Help topic, "Set tabs to close or delete 
them (for Word 2010)" or "Set, edit or clear tabs in Word 2007" 

Question 6: 
Explain the process of applying bullets to some paragraphs in a document. 

Answer 6: 
The process of applying bullets to some paragraphs in a document are listed 
below: 

• Step 1: Make sure you can see the list bullet style. 

a. On the Format menu, select Style and Format. The style and formatting 
task pane appear. Down the bottom, in the show box, select "All Styles. 

• Step 2: Apply the list bullet style. 

a. Click on the first paragraph you want bulleted. Select a list bullet in the 
style bar of the toolbar. This gives you a bullet at the beginning of this 
section. You have two more parts for formatting. You can select both at a 
time, and then apply the list bullet style to both at once. To do this, click 
anywhere in the section. Hold down the Shift key. Click anywhere in the 
second section. After that, use the "Style" box and select "List Bullets". 

• Step 3: Modify the list bullet style:  

a. We need to change the style of the list bullet to change the left indent. 
First, make sure the insertion point is in one of your list bullet paragraphs. 
In Word 2002, choose Format> style And Formatting. Set the Display to "All 
styles" at the bottom of the right pane. Now search "List Bulletin" in the list 
of styles. Right-click on the cursor list and select Modify. 



Question 7: 
What is tab? How do they assist in the process of formatting? 

Answer 7: 
The tab is a paragraph formatting aspect used to align text. When you press the 
TAB key, Word inserts a tab character and moves the insertion point to tab 
setting (called tab stop). You can set your own shortcuts or use the default Word 
shortcut settings. The tabs are adjusted to distribute the text evenly between the 
left and right margins. By default, the Word label is set every half inch. These 
tabs have small marks at the bottom of the horizontal ruler. 

If you do not want to use the default label set on a half-inch label, there are two 
options. Change the distance between default tabs / existing tabs or create your 
own tabs. 

The four most common types of custom labels are left-aligned, centre-aligned, 
right-aligned, and decimal-aligned. Custom tab settings are indicated by tabs on 
the horizontal ruler. 

There are two ways to set labels. Using the tabs dialogue box or the ruler. Using 
the ruler to set labels is a simple two-step process. Click the tab to the left of the 
ruler to select the route type, and then click the position on the ruler to set the tab 

Question 8: 
What is style? Discuss the steps involved in defining styles. What is the use of 
style for next paragraph? 

Answer 8: 
To define style we can simply follow these steps: 

• Choose style from the format menu. Word displays the style and dialog 
box. 
 

• If you want, you can choose one of the predefined styles displayed on the 
left side of the Style dialogue box. In many cases, they can save you a lot 
of standard word processing work. 
 

• If you selected a predefined style, click Change. To define a style from 
scratch, click Create. Either way, you see pretty much the same dialog box 
that allows you to set style properties. 

• If you are defining a new style, be sure to include the name and type of the 
style you want to create. You can also indicate whether this new style is 



based on (derived from) an existing style. 
 

• Click the Format button to change the actual formatting properties 
assigned to the style. The formatting types available depend on whether 
you are using a paragraph style or a character style. 
 

• After done with setting the formatting properties, click "OK" to close the 
dialog box. Word will display the Style dialog box again, and your style will 
appear in the list of available types. 
 

• Click Close to dismiss the Style dialog box. 

Question 9: 
How do you change the features of an existing style? 

Answer 9: 
Following are the steps to change the existing style of a document. 

• Select text or place a cursor at the beginning of the line which you want to 
format. 

• In the style group on the home tab, click the More drop-down arrow which 
displays more style options. 

• Select the suitable style from the drop-down menu. 

Question 10: 
How do you insert table in your document? Discuss the steps involved in splitting 
and merging cells. 

Answer 10: 
To insert a table in the document: 

1. Click on the Insert tab. 
2. Click the table button, select desired rows and columns by clicking the cell. 

Steps for the splitting of cells: 

1. To split the cell, click in a cell or select multiple cells. 
2. Under table tools, on the layout tab, in the merge group, click split cells. 
3. Then enter the number of columns or row that you want to split the 

selected cells into. 

Steps for merging cell 



1. Select the cell that you want to merge. 
2. Under table tool, on the layout tab, in the merge group, click merge cells. 

Question 11: 
Discuss the various text wrapping options available when you insert a picture in 
your document. 

Answer 11: 
There are various wrapping options available in MS-word. They are, 

Square, Tight, and Through 

1. ‘Square’ setting wraps text around the boundary of the object leaving a 
certain gap between image and text. 

2. “Tight” setting tries to wrap a text around the boundary of the object as 
closely as possible. 

3. If an object has a transparent background, “Through” setting allows the 
text to flow into the white space of the object. 

Top and Bottom  

1. This setting helps to keep text above and below the object. 

Behind Text and In front of the text. 

1. It doesn’t affect the text; the image will either appear behind or in front of 
the text. 

Question 12: 
Explain the utility of mail merge. 

Answer 12: 

1. Database and document is linked together to create and send the bulk of 
letters. 

2. Mail merges typically works with two documents excel sheet and letter 
template. 

3. The recipients’ data from spreadsheet goes to letter template, one by one, 
until all mails are created 

Question 13: 
Define mail merging in word processor. 



Answer 13: 

1. Mail merges works with two documents excel sheet and letter template. 
2. The process of sending bulk mail can be automatically done with mail 

merge.  
3. The recipients’ data from spreadsheet goes to letter template, one by one, 

until all mails are created. 
 

 

Multiple Choice Questions 
 

Identify the most appropriate option for the following: 
 
Question 1: 
To increase the space on the left for just one paragraph in a page, you can adjust 
(i) Left indent 
(ii) Right indent 
(iii) Alignment 
(iv) Tabs 
 
Answer 1: 
(iii) Alignment 
 
Question 2: 
When you want to repeat the same formatting at different places in your 
document, you can take the help of 
(i) Character formatting 
(ii) Paragraph formatting 
(iii) Style 
(iv) Tabs 
 
Answer 2: 
(iii) Style 
 
Question 3: 
Which of the following is not character formatting? 
(i) Text Colour 
(ii) Alignment 
(iii) Font 
(iv) Subscript 



 
Answer 3: 
(ii) Alignment 
 
Question 4: 
Which of the following is not a paragraph formatting? 
(i) Alignment 
(ii) Indentation 
(iii) Line Spacing 
(iv) Underline style 
 
Answer 4: 
(iv) Underline style 
 
Question 5: 
Which of the following cannot be included in a style? 
(i) Paragraph formatting 
(ii) Character formatting 
(iii) Table 
(iv) Numbering 
 
Answer 5: 
(iii) Table 


